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Introduction

AutoFlow Pro provides an extremely advanced solution for flowing and re-
flowing entire documents. With AutoFlow Pro you fully control the layout
of both text and images, using both master frames and non-master frames.
Please read this manual carefully and see our video tutorials as well, to fully
understand what AutoFlow Pro can do for you. Another valuable resource is
our online forums where you can find help with any issues you might have.
Once you understand the capabilities of AutoFlow Pro, we are confident that

AutoFlow Pro will change how you lay out documents forever!

AutoFlow Pro Basics

When laying out text in InDesign, the useris faced with some basic problems:

1. Text edited in InDesign does not flow dynamically. To correct the resul-

tant overset text, text frames must constantly be added and re-sized.

2. When laying out multiple columns in InDesign, text frames are flowed
to fill the first column before filling the second column. The only way to bal-

ance columns is to shrink the frames to fit the text.

AutoFlow Pro allows text frames to dynamically expand and shrink. The
automatic re-sizing can even be set for threaded stories. AutoFlow Pro does
not require the use of master text frames—an important advantage over

other products which offer auto-flow capabilities.

If you are familiar with PageMaker’s “springy” window-shades, and InDe-
sign CS4’s Smart Text Reflow, you will understand the basic AutoFlow Pro
settings. However, AutoFlow Pro goes far beyond the basic functionality of
either of these two functions. It will automatically identify whether the text

frame is snapped to margins, or column guides, set to a custom position,
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or is based on a master text frame. Depending on each of these situations,
AutoFlow Pro will flow the text in the appropriate way. Please see page 19 for
an in-depth explanation of Frame Types and how they behave.

Additionally, AutoFlow Pro can have different flow settings for different sto-
ries in your document. These settings can be set on six different levels as
explained on page 17. They can be set for both master text frames and regu-

lar text frames which are not connected to masters.

Advanced Features
AutoFlow Pro goes far beyond the basic text flow settings, which allow text
frames and pages to be added or deleted as you type or edit text. AutoFlow

Pro is a truly advanced pagination tool.

1. AutoFlow Pro can automatically determine which master pages are used
as the text flows, by creating master-page-to-paragraph-style links. When
AutoFlow Pro encounters a paragraph style which has a link defined, the
master page is automatically changed to the linked one, and the text frames

will be sized to fit. See page 35 for more details on Master Page Links.

2. AutoFlow Pro can be used to automatically repaginate your file as you
edit it. When used in conjunction with Story Tools, which can split a story
into smaller Story Strings, AutoFlow Pro can automatically add and remove

pages between articles as you edit text.

3. AutoFlow Pro allows you to simply set your text to Full Text Flow, and
your multi-column articles will always have the columns balanced at their

end.

4. AutoFlow Pro can be used to transform master pages into true dynamic

templates which can totally transform a live page by simply applying a new
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master page. Both text frames and graphic frames can be set up to be master
content holders and the content will dynamically reposition and optionally
resize themselves any time the page changes sides, or a different master page
is applied. It’s truly amazing to watch! Please refer to page 38 for more infor-
mation on Master Threads, and page 43 for information on Master Content
Frames.

AutoFlow Pro allows you to have complete control over how your layout will
look while automatically taking care to make sure that things don’t inadver-

tently change.

Once you use AutoFlow Pro, you will never look at master pages the same way
again!

nmm Please note: Because the Smart Text Reflow feature of InDesign
CS4 conflicts with AutoFlow Pro’s reflowing of text, setting any
of the six flow settings of AutoFlow Pro, automatically disables
Smart Text Reflow for the entire document. There will be
no warning of any kind. AutoFlow Pro is much more than a
replacement for Smart Text Reflow, so this should not be an
issue. However, with AutoFlow Pro, you must set each story

explicitly to flow.
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Examples of Use

The uses of AutoFlow Pro are extremely diversified. Below are just a few

examples of how AutoFlow Pro can be used to streamline your workflow.

Berkshire Encyclopedia of China

Brad Walrod recently headed a group of book compositors responsible for
laying out an encyclopedia of China. The project was a rather large one with
close to a thousand articles spread across many InDesign files. Part of the
challenge of the project was the application of the correct master page at the
start of each article. Additionally, the articles were to be laid out in a two-
column layout. The columns were to be balanced at the end of the articles
to maintain a balanced look. The articles changed sizes as the project pro-
gressed when text was edited or art was added and removed. Ensuring that
the layout retained its correct formatting was not a simple goal—especially

while the work changed hands among the different compositors.

AutoFlow Pro (while still in its alpha stage) was used in this project from the
start. AutoFlow Pro automatically applied the correct master pages when the
articles were placed. Story Tools (part of our Layout Tools plug-in) was used
to automatically split the articles into separate stories, and AutoFlow Pro
automatically balanced the articles and inserted/removed pages between

articles as needed.

Master Threads (page 38) and Master Page linking (page 35) were used
together with the Full Text Flow setting (page 18) to achieve the objective.
The use of AutoFlow Pro helped keep control of the project and saved count-

less hours of work.
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Examples of Use

Multi-Text Layout

One of the very big challenges of laying out technical Hebrew publications
is the composition of multiple related texts on the same page. This type of
complicated layout is commonly referred to (in the Hebrew typesetting
community) as “Rav” Text or Multi-Text layout. While AutoFlow Pro is not
intended to be a full solution for this kind of complicated layout, it can be

used to successfully make this kind of layout much less tedious.

In the example below, there are four different texts all being laid out in rela-
tion to each other. Some pages will contain all four texts, while others will
contain only the main commentary. All verso (left-hand) pages will contain
only the commentary text; some of the recto (right-hand) pages will con-
tain all the texts, and some only the commentary. Page sides can change as
text is flowed in and edited. With the appropriate application of AutoFlow
Pro settings, all texts will flow to the correct page placement, whether verso

or recto.

* a3 190 Aniu axin N3 997

T e Main Text

Commentary #1

— Commentary #2

Commentary #3
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The proper use of Master Threads can be used to easily add and remove the
different texts to individual pages as needed by simply changing master
pages. Additionally, the correct texts can be made to appear and disappear

automatically as sides change to keep the layout the way it was intended.

‘n . ‘71 ! ‘ua . ‘ZIE . ‘2&3 . |!sn . |432 . ‘soa . ‘575 . ‘sts . ‘nn . ‘792 . ‘354 . |Q!S . |mnx:I ® [ |WHidcen n
& [mreia am
Pra— i s i g
s -
oo Ll 0 i
L H
I I ol
Ly E 1751y
| L
P e — U5
= T 3
| :
KB
KB
) g KB,
F@E—d@ AL W
; s .
T 1) +

To achieve this, we need to create a few different master pages, and we will
use two different layers. Shown above is a screen shot of the master page
which will enable all the texts on the recto page, and disable all but the com-
mentary on the verso page. We use InDesign’s ability to thread text across
layers to our advantage. Each Master Thread on the recto page is threaded to
a corresponding text frame on the verso page. With the exception of the
commentary thread, they are all threaded to text frames on the hidden layer.
As soon as the text frames are properly threaded we hide the layer by click-

ing on the eye icon. o "
[~ Hidden
= [ |.Text Layer Am
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Since the hidden text frames were created too small to actually hold any text,

the text will not be composed on verso pages.

Once we set up master pages for the different scenarios with small text
frames on hidden layers for all the “non-active” text, we only need to change

the master page to add or remove text from a page.

A Master
Applied

B Master
Applied

Threaded to
Tiny Text Frames
on Hidden Layer
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Magazine Layout

One of the big challenges of magazine layout is dealing with typefitting of
articles—very often under tight deadlines. Small changes to copy can drasti-
cally affect the layout of the whole page. To keep the proper appearance of
the page after copy is added or removed, it is often necessary to alter many
aspects of the layout structure. This is a time consuming process as well as

being very error prone—especially when working under pressure.

AutoFlow Pro can be an incredible time-saver, and is indispensable in keep-
ing control of design quality and avoiding mistakes. To use AutoFlow Pro in
this, way, master page templates should be set up in advance with different
variations on the page design. These different master pages can be applied
on the fly to quickly see variations on the current layout or improve the

copy-fitting of article copy.
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Installation
AutoFlow Pro was developed using a product called “APID ToolAssistant”

created by Rorohiko. This necessary central controller does a lot of the low-
level processing. If you are interested in the technology behind the development,
you can read the addendum on page S7.

All the necessary components of AutoFlow Pro are installed in a single step

by our installers. The installer includes APID ToolAssistant as well.

To run the installer, simply double click on the installer package on Macin-
tosh or the installer wizard on Windows, and it will walk you through the

few steps required.

Macintosh Install

(o NeNé) ‘e Install Publisher Suite
- k l. Custom Install on “Macintosh HD"
INylools.com
Package Name Action Size

@ Introduction T InDesign CS3 Install 5.3 MB

# InDesign C54 Install 5.8 MB
8 Read Ma ™ InDesign CS5 Install 5.5 MB
O License ™ Documentation Install 11.8 MB

© Destination Select
© Installation Type
® Installation

® Summary

Space Required: 28.3 MB Remaining: 56.23 GB

( Go Back ) ( Continue )
P

On Macintosh you will be offered the option to install on CS3, CS4, or CS5

as shown above. The option to install any version not currently installed will
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be greyed out. We advise that you keep the option to install the documenta-
tion checked.

nmw Please note: If your installation of InDesign is not in the default
location, you will not be able to install on Macintosh! Before run-
ning the installer, make sure InDesign is located in: /Applications/
Adobe InDesign CSX.

Windows Install

Welcome to the In-Tools Setup
Wizard

This will allow you to modify, repair, update or remove
Reflective Objects for Adobe InDesign.

It is recommended that you dose all Adobe applications before
continuing.

[inltoolscom

[ Next = ][ Cancel ]

The Windows installer has the additional step that allows you to select your
InDesign folder:

Choose location of InDesign €54 folder. Setup will use location to install Reflective
Objects.

For example 'C:\Program Files\Adobe\Adobe InDesign C54' for InDesign C54.

To continue, dick 'Next', If you would like to select a different folder, dlick 'Browse'.

C:\Program Files (x86)\Adobe\Adobe InDesign CS4| Browse...
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Purchasing Licenses and Activation

In-Tools suites and plugin are activated from within InDesign using the
In-Tools Dashboard. To access the Dashboard, select “InTools > In-Tools
Dashboard..”. That will bring up the following dialog:

In-Tools Dashboard

Welcome, Harbs
lin!tools.com

m Plugins

! ‘ Product Status Latest Version
World Tools Activated 1.0.5 Update:

P it arL AutoFlow Pro Activated 18

Column Flow Activated 1.0.7
Style Utilities Activated 1.0.8
- Proper V1 Activated 1.0.6
Gt Help Reflective Objects Activated 1.0.5
Power Headers Activated 2.0.5
Side Heads Activated 1.0.7
Story Cantrol Activated 1.0.7
—
Heport H Bug Drop Words Demo: 23 days left Fictiuate 1.0.5

Drop Words creates “drop werds” commanly used In classic Hebrew typesetting.

The Dashboard shows all the information you need to know about your
plugins (or suites). To activate, simply click on the “Activate” button next to
the product you would like to activate. Ifit is installed as part of a suite, all the
components of the suite will be activated as a whole. Wait a few moments

while the activation process completes. hen it

Connecting to In-Tools Website. Please wait...

does, you will need to restart InDesign.
Cancel
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To activate, you must have a valid In-Tools account, and you will need to log
in from the Dashboard:

Emall: @ sales@In-tools.com Password: Fdk HEHEEEE

Login Automatically Remember Login

We recommend keeping both the “Login Automatically” and the “Remem-

ber Login” check-boxes checked. This will ensure you are always logged in
when the dialog is opened (assuming you have an internet connection). If
you try to log in with an email account which is not registered, you will be

given the option to create a new account.

You also must have purchased a license of the plugin to activate it. If you

have not yet purchased a license, you can do so using the “Buy” button:

By

For further questions and issues regarding licensing and activation, please

refer to the FAQ web page; or for more help, please visit our forum.


http://in-tools.com/learning/faq/
http://in-tools.com/learning/forum/
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Getting Started

AutoFlow Pro has six basic settings: 1. Add Pages 2. Expand Frames and
Pages 3. Full Text Flow 4. Resize Down §. Resize Up 6. Resize
From Center. These settings are divided into two basic groups. The first
three settings will add pages, while the last three will only fit a story’s last
text frame, but will not add pages. Setting #1 is similar to “Smart Text Flow”
in InDesign CS4, and setting #4 is similar to the “springy window-shades”
in PageMaker.

The exact behavior of each of these settings depends heavily on how your
text frame is positioned. AutoFlow Pro automatically identifies four different

types of text frames and behaves differently for each kind. The four different
kinds of text frames are: 1. Margin Frames, 2. Column Frames, 3. Custom
Frames,and 4. Master Frames. Each of these kinds of frames and how they
are identified will be explained in detail on page 19, but for the sake of sim-
plicity while explaining the difference between the six different settings, we

will assume that your text frames fit the margins of your page.

1. “Add Pages” does just that. It adds as many pages as needed to fit your
text when the last frame in your story is over-set. If there is a blank page
following your story with the same master page applied, a text frame will
be created on this existing page. Otherwise, pages will always be added at
the end of the current story, and new text frames will be created as neces-
sary to fit the page margins. A blank page is defined as a page with no text
frames which fall within the margin area. If you have text frames which fall
entirely outside the margins of your page, the page will still be considered to
be “blank”.
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2. “Expand Frames and Pages” expands the last frame in your story to the
bottom margin as you add text. It will only add as much space as needed to
fit your text. If the frame is over-set after it is expanded to the bottom mar-
gin, AutoFlow Pro will add pages as needed. It will not shrink frames—only
expand them. If your computer has a slower processor, you might want to
use this setting rather than “Full Text Flow” when you only need to expand
(and not shrink) frames. “Full Text Flow” has more overhead and may slow

editing more than “Expand Frames”.

3. “Full Text Flow” offers the same functionality as “Expand Frames and
Pages”, plus it shrinks frames and removes empty pages when text is deleted.
There is a slight delay (about a second) between editing and shrinking to
prevent constant processing while editing text. If you are using multi-column

frames, “Full Text Flow” will ensure that your columns are always balanced.

4. “Resize Down” will make the last text frame in a story “springy” so that
it will expand downwards to fit the contained text. It will fit itself to the text
as text is added and removed. New text frames will not be added. When the
text frame reaches the bottom margin, and the text remains overset, the text

frame will stop resizing and the text will remain overset.

5. “Resize Up” is similar to “Resize Down’, but instead of the text frame
expanding down, it will expand upwards. This is especially useful for manu-

ally positioned footnote frames.

6. “Resize From Center” is similar to the last two options, but the text
frame is expanded equally upwards and downwards. The frame expands

until it reaches either the top or bottom margins.

Regardless of which settings you choose, AutoFlow Pro will only adjust the
last text frame in your story. It will not adjust frames in the middle of your
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story flow (for example, even if it might be able to be shrunk to balance col-
umns, or expanded to fit more text). If you would like to fit intermediate text
frames (for example to balance columns better), you can do so manually by
selecting either “Shrink Selected Frame(s)” or “Fit Selected Frame(s)”. The
difference between these two options is that “Fit Selected Frame(s)” will
either shrink, or expand to fit as much text a possible while remaining within
the margins, while “Shrink Selected Frame(s)” will only shrink to fit the text

currently contained by the text frame.

- Please note: Because the Smart Text Reflow feature of InDesign
CS4 conflicts with AutoFlow Pro’s reflowing of text, setting any
of the six flow settings of AutoFlow Pro, automatically disables
Smart Text Reflow for the entire document. There will be no
warning of any kind. AutoFlow Pro is much more than a replace-
ment for Smart Text Reflow, so this should not be an issue.
However, with AutoFlow Pro, you must set each story explicitly

to flow.

Frame Types

As mentioned earlier, AutoFlow Pro identifies four different frame types
while flowing text, and will flow the text accordingly. Below is an explana-

tion of these different frame types and the differences between them.

Margin Frames

Margin Frames are frames which fit exactly within the page margins. Margin
Frames do not need to fit to the top or bottom margins. If they fit exactly
between the inner and outer page margins, AutoFlow Pro will identify them

as being Margin Frames. The flowing of Margin Frames is very simple: text
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frames will always expand downwards until they reach the bottom margin if
the flow setting is set to Expand Frames or Full Text Flow. If the flow settings
are set to add pages, new text frames will be added to fill the margins of the
following page. New text frames which are created while flowing text will
always fill the margins on the sides as well as on top and bottom. This is true

even if the previous text frame does not snap to the top or bottom margin.

Column Frames

Column Frames are identified as frames which are snapped on their sides
to column guides. Like Margin Frames, Column Frames do not need to be
snapped to the top or bottom margins. The main difference between Margin
Frames and Column Frames, is that Column Frames will be created and flow
to fill each column of the page in turn, while Margin Frames will fit the entire
page margins. It is important to note that when there is only one column
defined on the page, text frames will always be defined as Column Frames—
not Margin Frames. In situations where there is only one margin there is no
practical difference between them, but this can have an effect when there are
paragraph style-to-master page links as explained later. In right-to-left docu-
ments, the column direction on column frames is inferred from the Story

Direction of the story—not the Binding Direction of the document.

Custom Frames

Custom Frames are text frames which do not fit the definition of either Mar-
gin Frames, or Column Frames. Basically any frame which is not snapped
to either the page margins or column guides on both sides and not based
on master text frames will be considered Custom Frames. The behavior of
Custom Frames depends on which flow settings are chosen as well as some

preference settings. For all settings, the position of the Custom Frames on
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documents with facing pages will depend on the preference settings. There
are two possible positions: “Static Position” and “Spine Relative Position”
Static Position will place the new frames on the exact same coordinates,
while Spine-Relative Position will place them the same distance from the
spine. Usually “Spine Relative Position” will be the desirable setting for

documents with facing pages.

If “Add Pages” is selected, new text frames will be created as needed on new

pages in exactly the same location and size as the original.

If the “Expand” or “Full Text Flow” settings are selected, new frames will
be added with the same right and left positions (subject to the “Static” or
“Spine Relative” setting). The top of the frame will be the same as the origi-

nal, but the bottom will expand down to the bottom margin.

Master Frames

Master Frames are text frames which originated on master pages and were
overridden (partially detached from the master page) to flow the text into
them. When Master Frames are used, the text frames that are added by
AutoFlow Pro are always added as overridden master text frames, and they
are overridden and filled with text only as needed. If the text frames are
threaded on the master page/master thread, each text frame in the thread is
added to the local page as needed. If multiple master pages are being used in the
layout, it is very important to read about Master Threads on page 38.

When Master Frames are used, and the “Add Pages” setting is selected, mas-
ter frames will be overridden as needed and be correctly threaded. Only text

frames which are needed to flow the text will be overridden.
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When “Expand Frames and Add Pages” is selected, Master text frames, when
initially overridden will be sized to fit the text and will then expand up to the
size of the master text frame. When the size of the overridden frame reaches

that of the original master text frame, a new frame will be overridden in turn.

When “Full Text Flow” is selected, The text frames will be overridden as
described above, but the text frames will shrink and be returned to the mas-

ter page as they become empty as well.

nnm Setting up Master Frames with the “Full Text Flow” setting is a

very good way of creating a document which will balance mul-

tiple columns while constraining the text frame size.

Table of Frame Types and Behaviors

right to left docu-

ments is determined

selected in preferences.

If it’s not selected, new

Margin Column Custom Frames  Master Frames
Frames Frames
Special None The direction of col-  New pages will onlybe ~ New pages will only be
Notes umn frame flow for ~ added if the option is added if the option is

selected in preferences.

Ifit’s not selected, text

by the story direction = text frames will be frames will be overrid-
(not the document added to existing pages ~ den on existing pages
direction) which have the same which have the same

master page applied.
If Spine Reflective posi-
tioning is set in prefer-
ences, the position will
be the same distance

from the spine.

master thread.




Examples of Use

Margin
Frames

Column
Frames

Custom Frames

Master Frames

Add
Pages

Fits new frames to

page margins

Fits new frames to

column guides

Creates new frames
to original size and

position.

New frames are over-

ridden as needed. Each
text frame in the thread
on the master page will

be overridden in turn.

Expand
Text
Frames/
Full
Text
Flow

Fits new frames to
page margins, and
shrinks the frame to

fit the text.

Fits new frames to
the next column
guides, and shrinks
the frame to fit the

text.

Fits new frames to the
top and side bounds of
the original text frame,
and shrinks the frame

to fit the text.

Overridden text frames
will fit the top and side
bounds of the master
text frame and will
expand down to a maxi-
mum size of the master

text frame.

Resize
Down

Frame will expand
down to the bottom

page margin.

Frame will expand
down to the bottom

page margins.

Frame will expand
down to the bottom

page margins.

Frame will expand
down to the bottom
position of the master

text frame.

Resize
Up

Frame will expand
up to the top page

margin.

Frame will expand
up to the top page

margin.

Frame will expand up

to the top page margin.

Frame will expand up to
the top position of the

master text frame.

Resize
From
Center

Frame will expand
both up and down
equally. It will stop
expanding when
it reaches either
the top or bottom

margin.

Frame will expand
both up and down
equally. It will stop
expanding when
it reaches either
the top or bottom

margin.

Frame will expand both
up and down equally.
It will stop expanding
when it reaches either
the top or bottom

margin.

Frame will size from the
center of the master
text frame. It will stop
expanding when it
reaches either the top
or bottom of the master

text frame.
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Applying Settings

APID ToolAssistant... i
AutoFlow Pro » Remove All AutoFlow Settings

Add Pages Automatically
Expand Frames and Pages Automatically
Full Text Flow

Resize Down
Resize Up
Resize From Center

Shrink Selected Frame(s)
Fit Selected Frame(s)

Disable AutoFlow Pro

Rebuild Current Story

Reflow Current Story

Reflow Current Story String

Force Recompose AutoFlow Pro Stories

Create Paragraph Style to Master Links...

- -

Define Master
_;:1 ne iasie

Content Frame...

Define AutoFlow Pro Styles...
AutoFlow Pro Preferences...

AutoFlow Pro Remove All AutoFlow Settings
Reflective Objects > Add Pages Automatically
Paste EAY Expand Frames and Pages Automatically
v Full Text Flow
Font
Size > Resize Down
. Resize Up
Find/Change... 38F

Resize From Center

One important difference between AutoFlow Pro and Smart Text Reflow in
InDesign CS4 is: Smart Text Reflow is a document-wide property. You can’t
fine-tune it—it’s either on or off for a whole document. AutoFlow Pro’s prop-
erties work story-by-story—you turn it on for each story you want to reflow
intelligently. AutoFlow Pro does nothing unless you set it to work on your
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story. You cannot set different settings on different frames in one story, but
you can have different settings on different stories. Above are screen-shots

of the AutoFlow Pro menus.

Settings are applied via a contextual menu. Right-click (or control-click)
on a text frame, or in the text, to bring up the contextual menu. Under the
AutoFlow Pro menu the are seven auto-flow options : “No Setting” , “Add
Pages”, “Expand Frames and Pages” and “Full Text Flow” as well as “Resize

» «

Down”, “Resize Up’, and “Resize From Center”. Each of these settings are

described above. The current setting will have a check mark next to it.

Alternatively, you can access the settings via menu items. Select InTools >
AutoFlow Pro > [Preferred Setting]. If you apply the settings on a regular
basis, you can assign a keyboard shortcut (see page 48).

When you apply AutoFlow Pro settings to a story, an icon will appear on the
bottom right corner of each text frame in the story to indicate the AutoFlow
Pro status. The six icons are as follows: Add Pages: B Expand Frames: U

Full Text Flow: t/} Resize Down: § Resize Up:  and Resize From Center: $

You can turn the visibility of the icons on and off by selecting View > In-
Tools > Hide/Show AutoFlow Settings

i The icons are customizable. All you need to do is to change the
png files in the AutoFlow Pro folder to icons more to your lik-
ing. Make sure to create and include an alpha channel in the file
to ensure that the transparency is preserved. If you do create a

custom icon set, we'd love to see them and share!
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Globally Disabling AutoFlow Pro

There are times that you might be doing editing on a document and you
don’t want pages added and removed while working. While it is possible to
remove AutoFlow Pro settings for specific stories, very often that’s not a good
option. For instance, you might want to disable AutoFlow Pro only tempo-

rarily, or for many stories at once.

Whatever the reason, you have the option to temporarily disable AutoFlow
Pro. It is important to note that disabling AutoFlow Pro only disables the
expanding (and shrinking) of text frames and the adding (and removing)
of pages.

nmp- Even with AutoFlow Pro “disabled”, Master Threads (page 38)

will reflow when master pages are changed.

To disable AutoFlow Pro, just select InTools > AutoFlow Pro > Disable
AutoFlow Pro. While AutoFlow Pro is disabled, there will be a check mark
next to the menu item to indicate the status. The disabled status is temporary
and will revert to being enabled when a document is closed and reopened.
When reenabling AutoFlow Pro manually, all AutoFlow stories will be auto-

matically recomposed.

Reflowing Stories
As pictured above, two of the options of AutoFlow Pro are “Reflow Current
Story” and “Reflow Current Story String”. These options do two things:

1. These options enable intelligent flowing of stories which do not have

AutoFlow Pro settings applied, or if AutoFlow Pro is temporarily disabled.

2. These options enable the reflowing of stories to ensure the proper mas-

ter pages and text fitting without deleting pages—even once the text is set.
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The difference between the two commands is: “Reflow Current Story” will
reflow just the currently selected story. “Reflow Current Story String” will
reflow the entire String of stories related to the currently selected story. The
“Reflow Current Story String” command will only be available if the selected
story is already defined as being part of a Story String. This is very useful for
ensuring that an entire document has the correct master pages applied. Story
Strings are set up using the Story Tools plug-in. Please refer to the Story Tools
documentation for details.

Rebuilding Story Threading

There are times when the text frames in a story might not sit in the correct
positions. For instance, text frames might have been removed in the middle
of the text frame threading, or master pages might have been changed with-
out Master Threads being set up. Simply reflowing the story will not help in
these instances. Reflowing the story will not remove existing text frames or
pages unless it is required to do so to flow through new master text frames.

To totally reflow the text again requires much more drastic measures.

To totally reconstruct the threading of the current story, select InTools >
AutoFlow Pro > Rebuild Current Story. This will remove all text frames
except the first one, as well as all pages rendered empty, by removing the text
frames; and will recreate all the text frames and pages based on the current
AutoFlow settings. This option is only available if one of the settings which
creates text frames is selected (i.e.: “Add Pages”, “Expand Frames and Pages”,
or “Full Text Flow”). Please be aware that the effects of this command
are quite drastic and use it with care! If it is used unintentionally, it can

be undone.



http://www.in-tools.com/plugin.php?p=20
http://www.in-tools.com/downloads/StoryTools.pdf
http://www.in-tools.com/downloads/StoryTools.pdf
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AutoFlow Pro Preferences

To access the preferences dialog, select: InTools > AutoFlow Pro -

AutoFlow Pro Preferences...
‘ . ‘ .

Default New Frame Settings: E
— ™

Ceneral Flow Settings:

Flow Type: | Page Flow I-ﬁ-l
Facing Pages: [Spine—Relati\re Positions I-G-l

Additional Flow Options:

["1 Add Pages for Custom-Positioned Frames
Ehdd Pages for Master Frames

E Flow Locked Frames

E Force Overrides on Master Frames
EPreser\re Resizing on Master Frames

E Reflow Master Frames When Side Changes

The Preference dialog offers the ability to configure preferences for many of

AutoFlow Pro’s functions.

1. e — This option defines the default for

—_— @) new text frames. If a new text frame is

created and the story does not already
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have an AutoFlow Pro setting applied and the object style is not linked to an
AutoFlow Pro setting, the selected Default Setting will be used.

Please note: These settings will only apply to new text frames. Existing frames
will not be affected.

2.  Flow Type: [ Page Flow i) AutoFlow Pro can be assigned to flow

text on both pages of a spread, or only on the recto (right-hand) or verso
(left-hand) pages. This takes place by assigning “Flow Type” as either “Page
Flow” or “Spread Flow”.

If “Page Flow” is selected, text will flow to the next page regardless of whether

it’s a recto or verso page. “Page Flow” adds pages one at a time.

If “Spread Flow” is selected, pages are always added in pairs. This keeps sub-

sequent pages from switching from recto to verso and vice versa.

When “Spread Flow” is selected, non-master text frames will always flow
from recto page to recto page and verso to verso. This is useful in situations
where the content on one side is different from the content on the other
side, as is often the case with texts that have translations or commentaries. If
the master pages applied to the recto and verso pages are different, the cor-

rect master pages on each side will be preserved as pages are added.

Please note: If master text frames are used, AutoFlow Pro will intelligently
determine whether the text should be flowed across the entire spread, or
just on individual pages. This is not effected by the “Page Flow” or “Spread
Flow” settings.

3. Facing Pages: | Spine-Relative Positions  [$] This option only affects Custom
Frames. All other frame types are positioned based on margins, columns, or

master page positions. This option has two settings: “Spine-Relative
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Positions” and “Static Positions”. “Spine-Relative Positions” will position
the Custom Frames relative to the spine on documents with facing pages.
“Static Positions” will always position new Custom Frames at exactly the

same coordinates as the original.

4.  []Add Pages for Custom-Positioned Frames 'This option determines whether
pages are added when custom frames become overset. If the custom frames
are set to add pages, new frames will be added on pages which already exist
regardless of whether this option is set or not. If this option is not selected,

new pages will not be created if none already exist.

S.  MIAdd Pages for Master Frames  This is similar to the last option, but it applies

to master text frames.

6. MFlowLocked Frames If this option is selected, AutoFlow Pro will flow and
resize frames regardless of their locked state. This is very useful if you want
to prevent accidental manual movement of the text frames, but would like

them to automatically resize and the text to reflow.

7.  MForce Overrides on Master Frames  If this option is checked and the master text
frames were set to not allow overrides, those settings will be ignored. If it is

not checked, the settings for not allowing overrides will be honored.

8. ™ Preserve Resizing on Master Frames 'This option determines the behavior
when relinking master text frames which have been defined as part of a Mas-
ter Thread (see page 38). When master pages change (as when a new master
has been manually applied, or the page side changes) the text reflows into
new master text frames. When this happens, all local overrides on the text
frame are lost. Very often, text frames are resized to accommodate the text

they hold. For example, frames might be made a line longer or shorter to
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better balance text. If you do not want to lose the manual sizing adjustments

to the master text frames, you should check this option.

9. [ Reflow Master Frames When Side Changes 'Lhis option enables text to reflow
into new master text frames when the page side changes. InDesign still keeps
the master text frames connected to the local ones even when the text frame
is located on the opposite side of the spread. This can cause text frames to
become doubled up. If this option is checked, AutoFlow Pro will remove the
original text frame and flow the text into new master text frames as

necessary.
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AutoFlow Pro and Object Styles

To access AutoFlow Pro’s object styles, select: InTools > AutoFlow Pro >
Define AutoFlow Pro Styles...

— Object Styles — AutoFlow Pro Settings
¥ [None] Default Settings
[Basic Graphics Frame] No Flow

¥ [Basic Text Frame] Add Pages

Main Text Frame
Two Column Frame
One Column Frame
[Basic Grid]
P Anchored Screen Shots

Expand Frames
Full Text Flow
Resize Down
Resize Up

Resize from Center

Anchored Screen Shots

— Defined AutoFlow Pro Styles:

Main Text Frame set to: Full Text Flow
Two Column Frame set to: Full Text Flow
One Column Frame set to: Full Text Flow

- — — — — — — PRI

— Style Structure View:

® o gApplv Changes to Existing Text Frames
"Based On" Style Groups

( OK 3 (Cancel)

AutoFlow Pro offers an advanced dialog for associating object styles with
AutoFlow settings. The dialog presents the object styles of the current docu-
ment in a tree format. There are two distinct tree structure views available.
There is the “Based On” view and the “Style Groups” view. You can switch
between the two views at any time by clicking on the appropriate radio
button.



— Object Styles

[None]

[Basic Graphics Framel

[Basic Text Frame]

[Basic Grid]

¥ Anchored Styles

Text Frame Styles
Main Text Frame
Two Column Frame
One Column Frame

1> P ) < | >

— Style Structure View:
() "Based On" @) Style Groups

— Object Styles

¥ [None
[Basic Graphics Frame]
¥ [Basic Text Frame]
Main Text Frame
Two Column Frame
One Column Frame
[Basic Grid]
»  Anchored Screen Shots
Anchored Screen Shots

T —————— y<

[»

— Style Structure View:
) "Based On" () Style Groups

AutoFlow Pro and Object Styles

Style Groups View

The “Style Groups” view presents the
styles in an expandable tree, with a
folder structure similar to the folder
structure of InDesign’s Object Style
panel. If you organize your object
styles in style groups, you can use
this view to select either individual

styles or entire style groups.

When a style group is selected,
all the styles (and sub-group
styles) in the selected style
group will be associated with the

AutoFlow setting you choose.

Based On View

The “Based On” view presents a tree
structure of all the styles, in which
each style can be seen in its relation
to the style upon which it is based.
The root of the style tree will always
be the [None] style as all styles

are ultimately based on [None].

When the styles are viewed in the
“Based-On” structure, all styles
which are based on the selected
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style will be associated with the
AutoFlow setting you choose.

Associating AutoFlow Pro Settings

— AutoFlow Pro Settings

Default Settings Defined AutoFlow Pro Styles:

Mo Flow Main Text Frame set to: Full Text Flow
Add Pages One Column Frame set to: Pl Text Flow
Expand Frames

Full Text Flow

Resize Down

Resize Up

Resize from Center

Once the object style or style group is selected in the tree view, all that is
needed to associate an AutoFlow Pro setting with an object style is to select
the desired setting from the item list. This will apply the selected setting to
all sub-styles of the selected tree item as well. The settings are immediately
reflected in the list of defined AutoFlow Pro styles below the list of settings.

Please note: Besides the six available AutoFlow Pro settings, there are another
two selectable options in the settings list: “Default Settings”, and “No Flow”.
There is a distinct difference between the two. “Default Settings” means
that the AutoFlow Pro settings will default to the setting which is set in the
AutoFlow Pro preferences dialog. If, for instance, the defaults in the prefer-
ences dialog (see page 28) are set to “Full Text Flow”, new text frames cre-
ated with a style set to “Default Settings” will have “Full Text Flow” applied
to it. The “No Flow” setting however, will ensure that your text frame with
the selected style will not have any AutoFlow Pro settings applied regardless
of the defaults settings.



Linking Paragraph Styles to Master Pages

EApply Changes to Existing Text Frames When YOll ﬁnish deﬁl‘lll’lg the Settll’lgs fOI‘ the ObjeCt
@ Cancel

styles, click OK to apply the changes. If you want
your changes to be applied to all existing text frames make sure that “Apply
Changes to Existing Text Frames” is checked.

nnm AutoFlow Pro settings are applied to stories—not text frames.
Setting a text frame to auto-flow will affect the whole story—
even frames with a different style. The last style applied to any
text frame in a story will define the AutoFlow Pro settings for the
entire story. Please take care in which order you apply styles
which have AutoFlow Pro settings!

Default settings and styles are saved within the document, and will be pre-
served when transferring the document to a different computer. If the file is
exported to the InDesign Exchange format (inx) or the InDesign Markup
Language (idml), all defaults including the defaults for styles will be lost,
but existing settings on frames will be preserved.

Linking Paragraph Styles to Master Pages

AutoFlow Pro has the ability to associate specific paragraph styles with spe-
cific master pages. This “style linking” gives the ability to have master pages
automatically applied while flowing text. When a linked paragraph style is
encountered at the start of a page, the master page linked to that style will be
automatically applied to the page.

nnm Please note: Style linking only works when AutoFlow Pro does
the flowing of the text. If you use InDesign’s built in auto-flow or
add text frames manually, the master pages will not be applied.

Additionally, it only works when text is initially flowed and the
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text frames are created. It will not work on text which reflows
through existing text frames unless the Reflow Current Story or
Reflow Current Story String commands are selected. For details

on how AutoFlow Pro reflows text please see page 26.

Creating Master Page Links

— Style Structure View: — Default Master Page
{® "Based On" () Style Groups [ TXT-Text pages H
— Paragraph Styles — Master Pages
¥ [No Paragraph Style] | Mo Link
N [Basic Paragraph] .v TXT-Text pages
gsl‘ilvnhs | Art-Article opener
Folin LET-Letter opener
HeadwordBioaraphy
HeadwordTitle
»  HeadwordTranslation
Letter
ProverbFirst
¥ ProverbSecond
ProverbThird

ReadingHead
¥ RunheadVerso
TableColumn

— Defined Master Links:

P TableNote
P TableText % “HeadwordTitle" linked to: Art-Article
TableTitle [ opener
[ )
<> s BER

o) ()

Creating Master Page Links is very simple. First create your paragraph styles
and master pages. Then select InTools > AutoFlow Pro > Create Paragraph
Style to Master Page Links... and the above dialog will appear. Select the
desired paragraph style from the style tree on the left, and the correspond-
ing master page the right.




Linking Paragraph Styles to Master Pages

As with the AutoFlow Pro style dialog, the style tree is viewable in two differ-
ent structure views: “Based On” and “Style Group”. In either view, all the sub-
styles of the paragraph style selection will be linked to the selected master
page. In the “Based On” view, all styles which are based on the selected style
will be included. In the “Style Group” view, any sub-styles of the selected
style group will be included.

Default Master Page

[ TXT-Text pages H

’fDefault Master Page

It is not necessary to create links for every paragraph style used. If almost
all your styles should start a specific master page, there is an easier way. You
have the option of selecting a default master page. If a default master page is
selected, all new pages will have the selected master page applied regardless
of which style is applied to the text. In this way, you can avoid defining links

for many paragraph styles unnecessarily.

In the dialog shown on the previous page, there are two master pages with
style links set up: the Article Opener master page, and the Text pages mas-
ter page. The Article Opener master page is linked to the HeadwordTitle
paragraph style. The Text pages master page is set as the default. With this
configuration, the Article Opener master page will be applied when the
HeadwordTitle paragraph style starts a new page. When any other paragraph
style starts a page, the Text pages master page will be applied.

Using Master Page Links
Once set up, Master Links work automatically. Any time AutoFlow Pro flows

or reflows text, the master page will be changed to match the correct master
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based on the style links or the default master. This is true for the Reflow Cur-
rent Story and Reflow Current Story String Commands as well.

If Master Text Frames are used, it is critical that Master Threads are set up. If
Master Threads are not set up, AutoFlow Pro will not change the master page

because it will not be able to flow the text into new text frames.

Master Threads

Conceptual Introduction
Master Threads are a novel concept, so it might take a bit of time to “get it”,
but the potential of using Master Threads is enormous, so it’s well worth the

time spent learning what Master Threads are, and how they can be used.

Simply put, Master Threads are Master Text Frames which are assigned to a

specific thread of text frames.

Normally, Master Text Frames can be threaded, but only with other text
frames on the same master spread. It is not possible to thread master text
frames from Master A to Master B. Therefore if flowing text, and the mas-
ter page applied changes from page to page, there is no way of dictating
which text frames, the text will occupy. Additionally, when a master page is
changed and a new one is applied, any Master Text Frames will be detached
from the master page. Master Text Frames in InDesign can be described as
static objects, that once overridden from the master page have very little to
do with the original object they started out being.

Master Threads were created to overcome these shortcomings. When Mas-
ter Text Frames are designated as being Master Thread Frames, they have

the ability of being virtually threaded across master pages, so a text frame
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(or thread of frames)on Master A can be associated with a text frame (or
thread of frames) on Master B. Additionally, Master Thread Frames can be
described as dynamic as opposed to the standard static Master Text Frames.

These two properties of Master Threads open up exciting new possibilities.

Let’s explain some more. Master Threads are created by naming a master text
frame or thread of master text frames. The name can be anything, but once
you name the text frames, they are defined as belonging to a Master Thread
of the name you chose. It is only possible to use a specific name once per
master spread. Text frames which have the same Master Thread name on
different spreads will be defined as belonging to the same Master Thread. In
this way, it is possible to create virtual threading between different master
pages. You can create an infinite number of Master Threads in each docu-
ment, which enables parallel flowing of stories (i.e. you can have two sepa-

rate stories which flow side by side, or top and bottom, etc.).

But What do They do?

Once Master Threads are properly set up, they can be used to intelligently
flow text. When used in conjunction with Master Page Links (page 35), Mas-
ter Threads can change the positioning and flow of text as the applied master
page automatically changes. When the text is flowed and master pages are
switched to match the linked paragraph styles, the text will flow into the text
frames on the new master page which correspond to the text frames on the
previous master page. This correlation is created by naming both sets of text

frames with the same Master Thread name.

This combination of master page linking and Master Threads enables the
complete automatic flowing of entire books, even when master pages must

change to reflect the text, and even when chapter openers must be placed in
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different locations than body text. This is true even if chapter openers are set

up as single column text, while the body text is set up as two columns.

In addition to the automatic layout made possible while initially flowing
text, Master Threads can transform master pages from a simple starting point
for layout, into true dynamic page templates. When text frames are defined
as Master Threads, the text contained by them will automatically reflow into
new text frames any time the master page changes or the page side changes.
This means, you can drastically change the layout of your text by simply
applying a different master page. With one click of the mouse, or by dragging
a master page onto a local page in your pages panel, you can rearrange your
layout! No more manually reflowing text when you see a need to change the

master page—even if your text does not fit the page margins!

Defining Master Threads
Defining master text frames as a Master Thread could not be easier. Just
select a text frame on a master page and select InTools > AutoFlow Pro >

Define Master Thread..., which will bring up the following dialog:

Label the Master Thread EMailnextﬂow .........................................

Main text flow -+

Cancel

Type in the Master Thread name or select a previously named one from the

drop-down menu. Repeat this procedure on all master pages on which text

of the same thread will be located. Once a master text frame is labeled with
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a Master Thread label, the label name will appear attached to the top left of
every text frame in the thread. This is true both for the text frames on the

master page as well as the overridden text frames on local pages.

Please note: There is a bug on some installations of Windows where it is not
possible to type a label name into the dialog. We have not yet been able to
identify what exact system configurations cause this problem. If you see this
problem, please download this script and run the script once. This should
solve the problem by reversing the structure of the combo-box in the dialog

when it is re-opened. The effects of the script should hold indefinitely.

Take care to run the script only once. Each subsequent run of the script will
cause the structure of the combo-box to be reversed. This reversal will either
fix, or break the functionality of the combo-box, depending on its previous

state.

The Master Thread labels can be hidden. To toggle the visibility of the labels,
select View > In-Tools > Hide Master Thread Labels

Hide Notes L | | |

In-Tools » Hide AutoFlow Settings

Hide Master Thread Labels

Hide Master Content Frame Labels

Using Master Threads

Once Master Threads are set up, you can lay out your book as usual. You don’t
need to do anything differently to ensure that your Master Threads flow cor-
rectly. If the story which uses your Master Thread Frames is set to AutoFlow
(see page 24 and page 32), the Master Thread Frames will be overridden (i.e.
transferred to the local page) automatically as needed. Manually overrid-

den text frames will keep their Master Thread status as well. The status of
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the Master Thread Frames become apparent when page sides change, or the
applied master page changes. In either of these scenarios, the text which
flows through the Master Thread Frames will automatically reflow into new

Master Thread Frames taken from the current master page.

When using Master Threads, there are two preference settings (see page 28)

which are important to note:

@Presewe Resizing on Master Frames
@ Reflow Master Frames When Side Changes

1. “Preserve Resizing on Master Frames” is an option which will keep the
dimensions of the text frame when reflowing the text into the new master
frames. This is important because the old frames are actually discarded when
the text content is reflowed. Very often text frames are resized to accommo-
date the text and you don’t want to lose those dimensions. It is important
to note that the sizing is only preserved if the two frames are considered
to be congruous. This is determined by examining the size and location of
the two original master frames. If the original Master Frame and the new
one into which the text is flowing are within one point of each other, they
are considered congruous, and the size will be transferred. Master Frames
are measured relative to the spine of the document, to preserve the layout

design of facing pages.
2. “Reflow Master Frames When Side Changes”: When the side of a

page changes in CS3 and later, an overridden master frame is not actually
detached from the master page. It is attached to a master item which doesn’t
really exist. When master pages are applied to a document page, the entire
master spread is applied to each page individually. You canlook at it as if every

page has all the items of an entire master spread on it, but only the items
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which corresponds to the current page side are actually visible. When the
page side changes, even overridden master items (even though they are now
within the visible bounds of the page) are still attached to the invisible mas-
ter page items which are outside the bounds of the page. This can result in
doubling of master items. If, for example, a recto page with overridden recto
master items becomes a verso page, the overridden recto items will be vis-

ible as well as the non-overridden verso ones.

AutoFlow Pro will eliminate these doubled frames by removing the overrid-
den one which is on the wrong page side, and overriding the corresponding
one on the current page side. If (for whatever reason) you want to preserve

these doubled up frames, you have the option of canceling this reflow.

nmm If you have a document which has text which should only
appear on either a recto or verso page, but there’s a chance for
page sides to change, it is advisable to create a master thread
which spans both pages. On the side which should not contain
the text, you should create the text frame too small to actually
hold any text. This will cause the text to “appear” and “disap-
pear” automatically as page sides change. You can place the
“blank” text frames in the page margins or on a hidden layer so

they will be out of the way.

Master Content Frames

AutoFlow Pro completes the concept of using master pages as dynamic tem-
plates by offering Master Content Frames. Just as Master Threads transform

the way text frames are automatically overridden and threaded as work pro-
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gresses, so too, Master Content Frames transform the way graphics frames

hold content.

Master Content Frames set the size and position of graphic objects prior
to their placement on the page. As in Master Thread Frames, when master
pages are changed, the content of Master Content Frames will be transferred
to the new corresponding Master Content Frames. If the size or location of
the graphic frames changes, the new size and location will be used. The new

frame fitting options will be honored as well.

The combination of Master Threads and Master Content Frames allows highly
structured layout to be set up in advance with multiple alternatives. Existing
layouts can be completely altered, with the text reflowing and the graph-
ics rearranging themselves to fit the new layout—totally automatically, by
simply applying a new master page. The application of Master Threads and
Master Content Frames to create dynamic master page templates will dramati-

cally increase your productivity!

Defining Master Content Frames

The process of defining Master Content Frames is very similar to the process
of defining Master Threads. Simply select a Frame or any object which can
contain graphics on a master page and select InTools > AutoFlow Pro >
Define Master Content Frame.... The labels are applied in the same way that
Master Thread labels are applied (see page 40), and the label will appear on
the top of the graphic frame as with master threads. The visibility is toggled
by selecting View > In-Tools > Hide/Show Master Content Frame Labels.
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Using Master Content Frames

For Master Content Frames to be effectively used, each master page which
could possibly be used should have corresponding Master Content Frames.
The Master Content Frames on each master can have unique placement and
fitting options. Fitting options can be predefined using InDesign’s Frame Fit-
ting Options. If the fitting options do not match, the content will be refitted
to the new fitting options. If no fitting options are set, the content will be
positioned and scaled proportionally to the existing positioning and scal-
ing. AutoFlow Pro uses a sophisticated algorithm to determine how the con-
tent should be positioned within the frame. If no Frame Fitting Options are
defined, AutoFlow Pro will determine whether the content is fit to the frame,

centered, or placed at a custom position and magnification.

Content of Master Content Frames can be any object type which can exist in
frames. This includes native InDesign objects such as rectangles, polygons,

text frames, lines, groups, etc. It can include linked graphics as well.

If the master page is switched to a master page which does not contain a
corresponding Master Content Frame, the frame will be disconnected from

the master and remain in it’s current position.

nmm If you are designing a layout which has a variable number of
graphics, you can have the graphics “appear” and “disappear”
when master pages are changed. To accomplish this, create
a hidden layer and place the Master Content Frames on this
hidden layer, for any page where you do not want a particular
graphic content to show. The graphic content will then “pop in

and out” automatically when master pages change.
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Other Commands
Shrink Selected Frame(s)
Fit Selected Frame(s)

Disable AutoFlow Pro
Rebuild Current Story
Reflow Current Story

Force Recompose AutoFlow Pro Stories

Shrink Selected Frame(s)

“Shrink Selected Frame(s)” will simply fit the selected frame or frames to
the smallest size which will not cause the text to be overset. This is similar
to the Fit Frame to Content command, but it works with threaded frames—
even frames in the middle of a story. “Shrink Selected Frame(s)” is useful
for balancing multi-column text frames. The command is honors AutoFlow
settings. If the story is set to Resize Up or Resize from Center, those settings
will be honored when resizing the frame. Otherwise the text frame will be

resized at the bottom.

Fit Selected Frame(s)

This option is very similar to the Shrink Selected Frame(s). The only differ-
ence between the two commands, is that Fit Selected Frame(s) will either
shrink or expand the text frame as necessary to fit the maximum amount of

text without going beyond the page margins.

Disable AutoFlow Pro
This command gives the option to temporarily disable flowing on stories set

to AutoFlow. For detailed information please see page 26.
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Rebuild Current Story

This command is a very drastic way of getting AutoFlow Pro to recompose
a story. It will remove all text frames except the first one, and if possible,
will remove pages as well. After the text frames are removed, it will re-create
them using the settings applied to the story. This command only works if a

story is set to add text frames.

We recommend only using this command if it’s truly necessary. It can some-
times cause major changes to your document. Please refer to page 27 for
further details.

Reflow Current Story / Reflow Current Story String.

This command forces the currently selected story to be reflowed. The text
frames will be fit as they would be when flowed for the first time, and any
Master page links will be used to correct the applied master pages. For full

information, please see page 26.

Force Recompose AutoFlow Stories

This command is used to force AutoFlow Pro to “wake up”. Under normal
circumstances this command should not be needed. However sometimes
stories might not be properly fitted because AutoFlow Pro was disabled, or
the document was edited on a computer without AutoFlow Pro installed.
Selecting this command when the file comes back to a computer with
AutoFlow Pro installed will get things back in order. The “Recompose All
Stories” command which is standard to InDesign should also work, but this

command is more direct.
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Shortcuts
All AutoFlow Pro commands can be applied using keyboard shortcuts or
with Quick Apply.

5] Quick Apply
& = full

F;] Active Page Item>Full Text Flow

P;I Active Page Item> Configure Column Flow

(= RIE

F;] Active Page Item=AutoFlow Pro Preferences...

F;I Active Page Item>Configure Reflective Defaults...

P;I Active Page Item>Configure Story Tools...

F;] Active Page ltem>Define AutoFlow Pro Styles...

P;I Active Page [tem>Disable AutoFlow Pro

E Active Page Item>Expand Frames and Pages Automatically

P;I Active Page Item=>Force Recompose AutoFlow Stories

gl e

To use quick apply, simply invoke the Quick Apply shortcut (Command/
Control Return) and start typing the name of the command. For example:
to set the current story to “Full Text Flow”, invoke Quick Apply and start
typing “Full..”. When Full Text Flow is highlighted, simply hit return to
apply it.

To create a keyboard shortcut for application of AutoFlow Pro commands,
open the Keyboard Shortcuts dialog (Edit > Keyboard Shortcuts...). Once
the dialog is opened, make sure “Active Page Item” is selected in the Product

Area drop-down. If you use a custom keyboard shortcut set, make sure your
set is selected.
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Set:

[ Harbs I-H ( New Set... ) ( Delete Set )
Product Area: ( Save j ( Show Set... )
[ Active Page Item l-ﬂ

Now we're going to create a keyboard shortcut for the Fit Selected Frame(s)
command which will make it very easy to shrink and expand specific text

frames at need.

P L* I DU - | PR - T | | [ -
Expand Selected Space Before

Fit Selected Frame(s)

Flow Stories In String Order

Footnote Numbering Formats...

In the “Commands” list, we selected the Fit Selected Frame(s) command.

Current Shortcuts:
Default: Ctrl+Cmd+F

Type Shortcut Here
Remove
New Shortcut: Context:
Ctrl+Cmd+H | [ Default Fi-l ( Assign )

Currently Assigned to:
Fit Selected Frame(s)

( Cancel )E oK 3

We then type Control+ Command+F (which is otherwise unused) into the
New Shortcut field and click “Assign”. Now we can use the shortcut to resize

the currently selected text frame or range of text frames.
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Compatibility and Known Issues

AutoFlow Pro fully supports InDesign CS3 and InDesign CS4. AutoFlow Pro
will work under InDesign CS2, but it is not recommended. AutoFlow Pro
has been highly optimized for performance in CS3 and CS4. These optimi-
zations do not work well with CS2 and the performance under CS2 will be

drastically degraded. InDesign CS is not supported at all.

We recommend a minimum of 2 GB of RAM when AutoFlow Pro will be
used extensively, although it will work with InDesign’s minimum system

requirements.

Rotated text frames will not expand correctly and new ones will not be cre-

ated correctly when flowed to a new page.

Text frames on rotated spread views (in CS4) will expand correctly if the
text frame is vertical when viewed. New frames created if text is flowed to

the next page will not be created correctly.

Whether or not we will give high priority to working around these limita-
tions will depend upon the feedback we receive. So, if flowing rotated text

frames or rotated spread views are important in your workflow, please let us

know!

AutoFlow Pro Dependencies

AutoFlow Pro does not create plugin dependencies. This means there should
be no issues sharing documents created while using AutoFlow Pro with other
users who do not have AutoFlow Pro installed. All AutoFlow Pro settings will

be preserved within the document as well.
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The only issue to watch out for, is when documents come back to an instal-
lation with AutoFlow Pro installed. If there are overset text frames, or text
frames which require reflow, there might be some layout changes when text

is recomposed (edited or reformatted).
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Scripting

Most of AutoFlow Pro’s commands can be accessed via scripting. Scripting
access to AutoFlow Pro is provided by sending custom events to the plugin.
To do this you must first get a reference to the AutoFlow Pro plugin. This
is done using the loadedScriptedPlugins document method. The loaded-
ScriptedPlugins method returns an Array. Therefore, to create a variable

which references AutoFlow Pro you'd write:

ExtendScript Code:
var autoFlowPro = myDoc.loadedScriptedPlugins("autoflowpro")[0]

AppleScript Code:
tell myDoc

set autoFlowPro to item 1 of (loaded scripted plugins label "autoflowpro™)
end tell

Visual Basic Code:
Set autoFlowPro = myDoc.LoadedScriptedPlugins("autoflowpro")[1]

Once you have a valid reference to AutoFlow Pro, you simply tell AutoFlow

Pro to handle a custom event:

ExtendScript Code:
autoFlowPro.handleScriptEvent (eventCode:String,[eventData:String],[delay:
integer]);

AppleScript Code:
tell autoFlowPro

handle script event event code (String) [event data (String)] [delay (Integer)]
end tell

Visual Basic Code:
autoFlowPro.HandleScriptEvent (eventCode:String,[eventData:String],[delay:
integer])
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In the above code, the event code is the custom event which you tell
AutoFlow Pro to handle. The event data is the data sent to the event handler,
although not all events require event data. The delay in milliseconds is when
the event is sent. This argument is totally optional. If left out, the event will
be sent immediately. If it’s 0, it will be sent when InDesign becomes idle.

Otherwise it will be sent after the specified delay.

Event Codes
Below is a list of acceptable event codes along with the description of what

they do and the required event data (if any):

Please Note: The event codes and event data are case sensitive.

Event Code Description Event Data

externalSetAutoFlow | Applies AutoFlow Pro String of two comma
settings to the specified | separated items. The first
story or array of stories | item is the story id, while the
second item is the desired
setting. Acceptable settings
are: “None”, “Add” “Expand”,
“Full” “Down”, “Up”, and “Out”.
To set multiple stories, the
event data for each story
should be separated by a
colon.

Examples in ExtendScript:
To set story with id 291 to Full Text Flow:
autoFlowPro.handleScriptEvent ("externalSetAutoFlow","291,Full");

To set story with id 291 to Full Text Flow, and story 264 to Add Pages:
autoFlowPro.handleScriptEvent ("externalSetAutoFlow","291,Full:264,Add");
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Event Code

Description

Event Data

externalTriggerFlow

Forces AutoFlow Pro to
compose a story with
AutFlow Pro settings
applied. This command
is useful if you need the
text to be flowed before
proceeding in your script

It accepts a single story id as
a String

Example:

autoFlowPro.handleScriptEvent ("externalTrigger

Flow","291");

externalShrinkFrame

Vertically shrinks the
text frame to the
smallest size possible
without causing the text
frame to become overset

Accepts the id of the text
frame as a String. It can
accept ids of more than one
frame separated by a comma.

Example: (given a text frame with an id of 487)
autoFlowPro.handleScriptEvent ("externalShrinkFrame","487");

To shrink multiple text frames: (with ids 487 and 562)
autoFlowPro.handleScriptEvent ("externalShrinkFrame","487,562");

externalFitFrame

Fits the text frame to
the text. It will either
shrink the frame or
expand it down to the
bottom page margiin as
necessary.

Accepts the id of the text
frame as a String. It can
accept ids of more than

one frame separated by a
comma. Syntax is the same as
externalShrinkFrame

externalFlowStory

Will AutoFlow a story or
list of stories. If there

is an AutoFlow seeting
set, it will flow the text
based on the current
setting. Otherwise it will
add/fit the text frames
as needed

Accepts the id of the stroy as
a String. It can accept ids of
more than one story separated
by a comma. Syntax is the
same as externalShrinkFrame
with the exception that the id
must be a story id—not a text
frame id
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Event Code Description Event Data
externalDisable Temporarily disables None
Autoflowing for the
whole document
externalEnable Re-enables the None
autoflowing after it has
been disabled
externalRecompose | Forces all AutoFlow Pro None

stories to recompose

externalLabelMasterThread

Sets a label for a Master
Thread

Comma separated string of
two items: the story id and
the Master Thread Label

Example: (given a story on a master page with an id of 291)
autoFlowPro.handleScriptEvent ("externalLabelMasterThread","291,Main Text");

externalLabelMasterContent

Sets a label for a Master
Content Frame

Comma separated string of
two items: the page item id
and the Master Content Label

Example: (given a graphic frame on a master page with an id of 723)
autoFlowPro.handleScriptEvent ("externalLabelMasterContent","723,Picture 1");
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Sample Script
Below is a sample script which will set the current story to Full Text Flow:

var doc = app.documents[0];
var story = app.selection[0].parentStory;
var id_as_string = String(story.id);
var autoFlowPro = doc.loadedScriptedPlugins ("autoflowpro™)[0];
if(autoFlowPro){// if AutoFlow Pro is not loaded, the item will be undefined
autoFlowPro.handleScriptEvent ("externalSetAutoFlow",id_as_string+",Full");
} else {
alert("AutoFlow Pro not loaded!");

b

Here’s the same script in AppleScript:

tell application "Adobe InDesign CS4"
set myStory to parent story of item 1 of selection
set theDocument to active document
tell theDocument
set myStoryID to id of myStory as string
set myEventString to myStoryID & ",Full"
set autoFlowProPluginList to loaded scripted plugins label "autoflowpro"
if length of items of autoFlowProPluginList is greater than 0 then
set autoFlowProPlugin to item 1 of autoFlowProPluginList
tell autoFlowProPlugin
handle script event code "externalSetAutoFlow" data (myEventString as
string)
end tell
end if
end tell
end tell
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Script Labels

APID, (and in turn AutoFlow Pro) makes extensive use of script labels for
tracking objects. If there is a script label applied to story, it will have the
AutoFlow Pro label added to the existing string when you use AutoFlow Pro
commands. If you must use script labels on stories, ideally you should use
private labels (used with the insert label and extract label methods). If you
must use the public labels you should append the existing labels instead of
simply replacing the existing ones. Otherwise you stand the risk of tram-

pling AutoFlow Pro settings specific to stories and/or frames.

In other words, always use:

myStoryOrPageltem.insertLabel("myCustomLabel")

or if absolutely necessary:

myStoryOrPageltem.label = myStoryOrPageltem.label+"myCustomLabel"

instead of:

myStoryOrPageltem.label = "myCustomLabel"

Addendum

What is “APID ToolAssistant”?

Classically, there are only two ways to automate InDesign. One way is by
scripting. Scripts are a series of commands written in one of the three sup-
ported scripting languages — AppleScript for the Macintosh, Visual Basic
for Windows, or ExtendScript for both platforms. ExtendScript is Adobe’s
version of javascript. For scripts to run, they must be placed in the applica-
tion script folder and explicitly run. For automation to be truly automatic,

it requires “event processing”. This means that certain events trigger specific
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processes to take place. There is limited event-triggered scripting available
in CS3.

To achieve true integration, plug-ins must be programmed using C++. Devel-
oping c++ plug-ins is a very involved, and lengthy process. APID ToolAs-
sistant is a plug-in which allows very fine-grained event processing using
ExtendScript. It allows for creation of advanced plug-ins in a fraction of the
time required when programming using c++. It also aids in the creation of

hybrid plug-ins which mix ExtendScript and c++ for maximum efficiency.

Without the APID ToolAssistant, it would not have been possible to create
the collection of plug-ins we offer in the same amount of development time.
This increased programming efficiency means more functionality for the

end user and lower prices.

Additionally, APID ToolAssistant offers the ability to attach scripts to spe-
cific objects. These attached scripts can be run automatically when triggered
by specific events. Anyone who has a licensed version of the APID ToolAs-
sistant plug-in installed can create and use these attached scripts. There
are also additional scripting properties and methods which are usable by

scripters. For more information see Rorohiko’s web site.


http://www.rorohiko.com/wordpress/indesign-downloads/active-page-item-developer/
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License Agreement
Please read the following document carefully!

This is a legal agreement (the Agreement) between you and Print Israel LLC (In-
Tools), the developer of the In-Tools software. This Agreement pertains to your use
of the In-Tools software and documentation which are provided to you by In-Tools
(collectively, the Software). By copying, installing, or otherwise using the Software,
you accept all the terms and provisions of the Agreement.

Terms of Use
The provisions of the In-Tools Privacy Policy are incorporated herein and made a part

hereof.

License

This Agreement grants you a personal, non-exclusive, non-transferable, non-sublicens-
able right to use one copy of the Software for use on a single computer and/or worksta-
tion for each license that you purchase. You may try the Software before purchasing a
license, for the specified amount of time in the materials accompanying the Software.
YOU UNDERSTAND AND AGREE THAT BY USING THE TRIAL SOFTWARE,
AFTER THE AMOUNT OF TIME YOU MAY NOT BE ABLE TO CONTINUE
TO USE THE SOFTWARE UNLESS YOU PURCHASE A LICENSE.

In-Tools reserves all rights in the Software not expressly granted herein, including
without limitation, ownership and proprietary rights.

License Restrictions
You may not reverse engineer, decompile or disassemble the Software. The restrictions

contained herein apply equally to any updates that may be provided to you by In-Tools.

Intellectual Property Rights and Third Party Materials
All service marks, logos, trade names, trade dress, and trademarks of In-Tools (col-

lectively Marks) are the exclusive property of In-Tools and nothing in this Agreement


http://in-tools.com/privacy.html
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shall grant you the license to use such Marks. All intellectual property rights in the
Software are owned exclusively by In-Tools and are protected by United States of
America copyright laws and international copyright treaty provisions. Any violation of
the terms set forth herein is expressly prohibited by law and may result in severe civil

and criminal penalties.

Disclaimer of Warranties

ALL SOFTWARE PROVIDED BY IN-TOOLS ARE PROVIDED AS IS. IN-TOOLS
AND ITS AGENTS, PARTNERS, OR EMPLOYEES MAKE NO REPRESENTA-
TION OR WARRANTY TO YOU OR ANY OTHER PERSON OR ENTITY,
WHETHER EXPRESS, IMPLIED, OR STATUTORY, AS TO THE DESCRIP-
TION, QUALITY, TITLE, NON-INFRINGEMENT, MERCHANTABILITY,
COMPLETENESS, OR FITNESS FOR A PARTICULAR USE OR PURPOSE AS
TO THE SOFTWARE PROVIDED TO YOU, OR AS TO ANY OTHER MATTER,
ALL SUCH WARRANTIES HEREBY BEING EXPRESSLY EXCLUDED AND
DISCLAIMED.

NEITHER IN-TOOLS NOR ANY OF ITS AGENTS, PARTNERS, OR EMPLOY-
EES WARRANTS THAT THE SOFTWARE OR SERVICES ARE ERROR FREE
OR WILL OPERATE WITHOUT CAUSING LOSS OR INTERRUPTION OF
YOUR COMPUTER USAGE OR DATA. YOU ASSUME TOTAL RESPONSIBIL-
ITY AND RISK FOR YOUR USE OF THE SOFTWARE.

Limitation of Liability

IN NO EVENT SHALL IN-TOOLS, ITS AFFILIATES, SUBSIDIARIES, PAR-
ENT COMPANIES, AGENTS, NETWORK SERVICE PROVIDERS, PART-
NERS, OR EMPLOYEES BE LIABLE TO YOU OR ANY THIRD PARTY IN ANY
RESPECT FOR ANY COSTS OR DAMAGES ARISING EITHER DIRECTLY
OR INDIRECTLY FROM THE USE OF IN-TOOLS SOFTWARE, INCLUDING
WITHOUT LIMITATION ANY ACTUAL, INCIDENTAL, CONSEQUENTIAL,
EXEMPLARY, PUNITIVE, RELIANCE OR SPECIAL DAMAGES, OR FOR
ANY LOSS OF REVENUE, PROFITS, USE, DATA, GOODWILL OR BUSINESS
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OPPORTUNITIES OF ANY KIND OR NATURE WHATSOEVER, ARISING IN
ANY MANNER FROM ANY CAUSE OF ACTION OR CLAIM RELATING TO
THIS AGREEMENT, TO THE SERVICES PROVIDED BY IN-TOOLS OR TO
THE USE OF THE SOFTWARE. THIS LIMITATION OF LIABILITY APPLIES
EQUALLY TO ANY THIRD PARTIES WITH WHOM IN-TOOLS ENTERS INTO
A BINDING AGREEMENT TO MARKET, DISPLAY AND/OR DISTRIBUTE
THE SOFTWARE TO END USERS AND SUCH THIRD PARTIES SHALL NOT
BE LIABLE TO YOU OR ANY OTHER THIRD PARTY FOR ANY OF THE DAM-
AGES SET FORTH ABOVE.

Export Control Laws.

You agree to comply with all laws, rules and regulations applicable to the export of the
Software. Specifically, you shall not export, re-export or transship the Software, or the
direct product thereof, in violation of any United States laws and regulations which
may from time to time be applicable. None of the Software or underlying information
or technology may be downloaded or otherwise exported or re-exported (i) into, or to
anational or resident of Cuba, Iran, Iraq, Libya, North Korea, Sudan, Syria or any other
country to which the U.S. has embargoed goods; or (ii) to anyone on the U.S. Treasury
Department’s list of Specially Designated Nationals or the U.S. Commerce Depart-
ment’s Table of Denial Order. By downloading or using the Software, you are agreeing
to the foregoing and you are representing and warranting that you are not located in,

under the control of, or a national or resident of any such country or on any such list.

Jurisdiction and Other Provisions

This Agreement and the relationship between In-Tools and you shall be governed in
accordance with the laws of the State of Delaware. Any dispute between you and In-
Tools regarding this Agreement will be subject to the exclusive jurisdiction of the state
and federal courts in the State of New York. You agree to submit to exclusive jurisdic-
tion in the State of New York, and you expressly waive all defenses to jurisdiction.

This Agreement is the entire agreement between you and In-Tools relating to your use

of the Software and supersedes any other communications or advertising with respect
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to the Software. If any provision of this Agreement is held invalid, the remainder of
this Agreement will continue in full force and effect. In-Tools failure to insist upon or
enforce strict performance of any provision of this Agreement shall not be construed
as a waiver of any provision or right. Neither the course of conduct between the par-
ties nor trade practice shall act to modify any provision of this Agreement. In-Tools
may assign its rights and duties under this Agreement to any party at any time without

notice to you.

Modifications of Agreement

In-Tools may modify this Agreement at any time without providing notice to you.
Such modification will be made by posting a revised agreement on its web site and
such modification shall be deemed effective immediately upon posting of the modified
Agreement. Your continued access or use of the Software or Services shall be deemed
your acceptance of the modified Agreement. You agree to check our web site periodi-
cally to review such modifications.

Termination or Modifications of Software

You may terminate this Agreement at any time. In-Tools may immediately terminate
the Agreement if you breach any representation, warranty, agreement or obligation
contained or referred to in the Agreement. Upon termination, you must dispose of the
Software and all copies or versions of the Software by destroying the Software. In-Tools
reserves the right to modify the Software at any time without providing notice to you.
In-Tools right to modify the Software applies to all or any aspect of the Software.

YOU ACKNOWLEDGE THAT YOU HAVE READ THIS AGREEMENT AND
UNDERSTAND IT AND THAT, BY USING THE SOFTWARE AND WEB SITE,
YOU AGREE TO BE BOUND BY ITS TERMS AND CONDITIONS.
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